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1 Introduction

This is a tutorial for the PICED software. By following the steps in this guide, you will gain enough
knowledge of the software to be able to start creating your own projects.

Guidance is also given in how to make projects which are attractive and easy to use. This is critical to
ensure that the users of your projects are satisfied.

This document does not provide details of how each function works. For more information, refer to the
other PICED help files and manuals.

1.1 Version

Version 4.13.

1.2 Typographic Conventions

When reference is made to a software button or menu item, the name (or text) is written in bold. Menu
and submenu items are separated by a vertical bar. For example, Edit | Undo would refer to the "Undo"
menu item in the "Edit" menu.



PICED Tutorial4

© 2015 Schneider Electric (Australia)

2 Before you Start

2.1 Software Concept

Before you start creating your own PICED project, run the software and open a few example projects to
familiarise yourself with what PICED projects look like and to get some ideas of what is possible.

2.2 Project Structures

There are several common ways of structuring a PICED project. The first is to have a main menu page
with links to all other pages as shown below. Each page has a "back" button to link back to the main
page. A common variant of this is to have an image of a site floor plan on the main menu page, with
invisible buttons linking to pages for each room. This is useful for projects with small screen sizes (such
as for black and white C-Touch) as little of the screen is used for buttons on all pages except for the
main menu.

The next common way of structuring a project is to use a "tabbed" structure, similar to that shown
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below. In this case, each page links to every other page and the selected page is highlighted. This has
the advantage that you can very quickly navigate from any page to any other. Most of the theme
templates work this way.

The last method is to use "next" and "previous" buttons to link each page to the next one and the
previous one in a circle, as shown below. This is useful for projects with small screen sizes (such as for
black and white C-Touch) as little of the screen is used for buttons.
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2.3 Fulfilling User Requirements

Prior to commencement of a real project, the installer should visit the customer with a laptop and show
examples of sample PICED projects and rough out the customer's requirements freehand on the Pro-
Forma forms provided. 

The success of a PICED project is best judged on the basis of how well it meets the requirements of the
user. These requirements must be captured with the customer before and during the design of an actual
project. 

The project should follow the order indicated below:
Design the C-Bus Network(s) if not already installed
Show examples of sample projects to the customer
Use the storyboard to design the flow from one page to another
Design scenes 
Design schedules
Implement at office
Bring a laptop and "simulate" the project or run "live" on an existing Network
Make changes and repeat the above steps if necessary
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Install PICED and commission

Basic C-Bus Setup

A set of drawings showing the devices to be controlled by C-Bus should be available for reference. The
tags created by the C-Bus Installation Software are available to the PICED project under Project
| Project Details on the Project tab.

Story boarding

Once the lighting groups have been assigned, the overall look of the project should be sketched out
using the storyboard sheet (printed and copied to produce an adequate supply). The idea is to show how
one page flows to the next and how the pages are interconnected. 

The precise look of the pages need not be reproduced at this stage.

Scene Design

The combination of various loads, associated levels and ramp rates that comprise the scenes in a
project can create an effective lighting effect, which differentiates C-Bus from conventional lighting. In
addition to the aesthetic aspects of scenes their use in scheduling should not be overlooked.

Schedule Design

Following this, schedules should be planned out on the Schedule pro-forma. Some illustrations of
example schedules may provide a better understanding of how they can be used. The purpose-designed
scenes should also be incorporated into schedules.

Initial Implementation

Once the overall requirements have been recorded, the project should be designed at the office and
brought back when complete.  

Testing

The PICED can be used to demonstrate how the project will look when installed. 

Iteration

The PICED Software provides a quick convenient interface for designing control layouts. The prototypes
of the project can be run on a laptop at the most convenient place for the customer to see the project.
The customer should then be encouraged to explore two or three options during this step to engender
"ownership" of the design and help guarantee a satisfied customer.

Commissioning

When a PICED unit is programmed the quickest and most reliable method of transferring a project is via
the serial connection. A project that takes 5 minutes to transfer using a serial connection could take 45
minutes to transfer over the C-Bus Network.

In the case of a new installation, PICED is installed along with the rest of the C-Bus equipment and the
commissioning of PICED is carried out as part of the overall commissioning work.



PICED Tutorial8

© 2015 Schneider Electric (Australia)

The customer should be instructed on the use of PICED including :
Navigating between pages
Controlling C-Bus
Controlling and editing Scenes
Enabling and editing Schedules
Access Control (passwords)

The customer should also be provided with an archive of the Project file for safe keeping.
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3 Tutorial

In the following pages, a sample project will be created. This will introduce you to :
Story-Boarding the Project
Using Templates
Adding Pages and Components
Creating Scenes
Creating Schedules

There are many aspects of the PICED not covered by this tutorial. To learn about other features of the
software, refer to the other PICED help files and manuals.

3.1 Project Requirements

The project for this tutorial is in the Guide Example project.

For the purposes of this exercise, we are going to assume that C-Bus is installed in the house shown
below. We want to have control of lighting in some main areas, scene setting throughout the house and
scheduling for other functions. The unit will be installed in the family room.

The areas controlled by C-Bus are:
Living room 
Meals / Family room / Kitchen 
Entry hall
Porch 
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Garage 
Bedrooms 1, 2, 3 & 4
Study 
Laundry 
Bathroom
Toilet
Deck 
Garden lights 
Garden sprinklers 

Having identified the various areas under control we use the C-Bus Tool Kit to create a project and tags
to implement the basic layout of the house. The units in the Network are programmed according to
normal C-Bus practice and ultimately will be transferred and tested in final commissioning.

For this tutorial, we are going to use the "Home" C-Bus project supplied with the ToolKit software.

3.1.1 Story-Boarding the Project

A "Story-Board" can be used to sketch out how many Pages are needed, which Components will be
required and which Page Links will be needed to link them together.

Below is an example of the "hand drawn" storyboard for the first few pages of the project (see the
Programming Guide for a Pro-Forma). It has been decided to use a "tabbed" Project Structure with a
"welcome" page.
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The first page in the project is a "welcome" page which links to the family room page. The welcome page
image has an arrow drawn to the family room page showing the transfer of control. For clarity the page
links of the "tabs" has been left off.

The necessary level of detail has been written on each "page".

Once the overall story-board is sketched out, the schedules and scenes need to be designed.
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3.1.2 Scenes

The scenes in a project may be used to create a mood by ramping lights up or down at predetermined
rates. Another use for scenes is to enable several loads to be controlled at once for the purposes of
scheduling. 

The scenes shown in the example below are used in conjunction with the schedule section which
follows. Some example scenes which could be implemented by PICED as shown below  (see the
Programming Guide for a Pro-Forma) :

The Welcome Home scene is initiated by entry to the house. All main access lighting to common living
areas is activated. It can be directly triggered by PICED. In this scenario we imagine that a Group
Address called "Automatic Door" on the Control Application is set when the garage door is opened. This
is what triggers the scene. 

The movie scene provides a lighting configuration for movie watching. Some dim lighting is maintained in
access areas to allow people to move around the house during breaks in the movie but maintain the
mood. Some people prefer low level lighting in the actual room the movie is being shown in, this depends
upon the size of the television or projection screen and viewer preferences in combination. 

3.1.3 Schedules

Here is an example of some Schedules (see the Programming Guide for a Pro-Forma) :
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Each schedule is given a "Name" which describes the purpose of the schedule. The details of the "Load"
(from the C-Bus project) can also be written in. 

The porch light, for example is to be turned on automatically each evening and so has a schedule entry.
The lighting requirements in this case are different according to whether it is a weekday or the weekend
(and hence requires two separate schedules).

Some schedules may be different depending on the season. In our example, the Irrigation schedules
which activate the Irrigation Control need to come on a different times during the year. This can be
achieved by :

selecting different months for each of the two Schedules in the Schedule Editor; or 
using an enabling Group Address which is enabled only during the Winter months for the Winter
Schedule. So although the Irrigation schedule in this case would contain no limits except for the hours
of operation, it is enabled by the Winter Group Address which is only on during that time. The
Summer Schedule would be implemented in the same way.

One other point regarding the actual event being scheduled: the event can be either Group Address
related or Scene related. In the former a Group Address is pulsed for a given period or set to a particular
level. In the latter a scene is fired at the scheduled time.

3.2 Creating a Personal Template

Before starting on the creation of your first real project, you should create a Template which you will use
for your future Projects. The benefit of doing this is that you can avoid having to do the same work every
time you start a new project.

Creating a New Project

The first step is to create a new Project. If the PICED software is already running, select the File | New
Project menu item. Otherwise, starting the PICED software will bring up the New Project wizard.

Select the Create a New Project Based on a Theme button. Select the Shadows theme for this
example.

Click on Next.

Select the required project type. In this case, select Colour C-Touch and click on Next.

Select any C-Bus project. This will be changed when you create a real Project, so the choice is
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irrelevant. Click on Next.

Click on Next again.

Setting Up Personal Details

As the project will be different each time, leave this blank for now. When you are creating a real project,
you should fill in this information. Click on Next.

Fill in your details and click on Next.

Select any preferred options, then click on Next.

Click on Next.

Select your location from the list. If your location is not in the list, enter the details manually and click on
the Add to Database button. Click on Next.

Select your time zone and Daylight Savings details. Click on Finish.

Setting up the Project Appearance

If you want to have particular Pages in your Project each time (for example, an introduction page or main
menu), then add these. It is worthwhile spending a little time  to make these pages attractive, as it will
be used many times in the future. You may prefer to do this after the tutorial when you have a little more
familiarity with editing projects.

Saving the Project

Click on the File | Save as Template menu item. Click on OK. Navigate to the Templates\Themes
\Colour folder. Enter the file name "my template" and click on OK. 

Re-using the Project

Whenever you create a new project, you can load the template you have just created. The next time you
open the New Project wizard, the template will already be in the drop down list. 

3.3 Creating the Project

We will now create a sample PICED project.

3.3.1 Selecting the Template

Click on File | New Project. Select Create a New Project Based on a Template. Select your
template created in the previous section. If you haven't created your own template, just select the
Shadows one.
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3.3.2 Customising the Template

The template currently has seven pages labelled "Page 1" to "Page 7". These need to be re-named.

Click Next twice. Select the C-Bus Project.

Keep clicking on Next until you get to Create Project Pages. Select Auto Create. Enter the names of
the pages for the project in the Page Names list to match the Story-Board :

Family
Lounge
Bedrooms
Study
Other
Outside
Scenes

When complete, click on Finish.

If you right click on the buttons, you will now see the pages change, and the selected page is identified
by the highlighted button.

3.3.3 Adding Pages

The template you have selected already has most of the pages needed, however you will need to add the
welcome page. 

Select the Page | New Page menu item. Enter the name "Welcome". Select a new page background
colour by clicking on Select Background Colour 1, selecting a new colour and click on OK. Click on
OK.

So that the PICED software knows that this is to be the start-up page, select the Project | Project
Details menu item. Go to the Options tab. Select the "welcome" page in the Start Up Page and Time-
out Page lists. Click on Finish.

For more information on adding pages, see the help files and manuals.

3.3.4 Adding Components

In accordance with the Story-Board, the welcome page needs a title, a picture and a clock.

Adding text

Select the Text toolbar item or Component | Place Text menu item. Enter the text "welcome" and
click OK. Place the text near the top of the page. Open the text component by double clicking on it or
selecting Edit | Component Properties. Click the Set Font button. Click the Select Other Fonts
button. Select a large script type font. Click on OK. Click on OK. Click on OK. 

Adding an Image
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Select the Image toolbar item or Component | Place Image menu item. Select the "smallhouse.bmp"
file in the guide example project and click OK. Place the image near the centre of the page. Open the
image component. Select the Page Link tab. Select the "Family" page. Click on OK.

Adding a clock

Select the Clock toolbar item or Component | Place Clock menu item. Place the clock near the
bottom of the page. Open the clock component. Select your preferred time format. Click on OK.

For more information on adding components see  the help files and manuals.

3.3.5 Adding Scenes

We will now add the "movie" scene which will do the following :
Set the Kitchen 1 light to 30% over 4 seconds
Set the Kitchen 2 light to 0% over 4 seconds
Set the Dining 1 light to 0% over 4 seconds
Set the Dining 2 light to 0% over 4 seconds
Set the Lounge light to 70% over 8 seconds

To add a Scene, click on the Scene button on the Tool Bar or the Project | Edit Scenes menu item.
Click on the Add button. Enter the name "Movie Scene". Select the Scene Components tab. Select
the Kitchen 1 & 2, Dining 1 & 2 and Lounge Groups in the Available Groups list and click on the >
button to add them. The Lounge level needs to be changed to 70%, so select the Lounge group in the 
Scene Components list. Select 70% and 8 seconds. Select the other groups and change the time to 4
seconds. Select the Kitchen 1 group and change the level to 30%. Click on OK. Click on OK.

For more information on adding Scenes see  the help files and manuals.

3.3.6 Adding Schedules

We will now add a Schedule which will switch on the porch light each week-day evening.

To add a Schedule, click on the Schedule button on the Tool Bar or the Project | Edit Schedules
menu item. Click on the Add button. Enter the name "Porch weekday". Select the Time tab and select
the time 19:00:00. Select the day tab and select every week day from the list. Select the event tab
and select Pulse Groups. Select the "Porch" group address. Set the level to 100%. Select a 4 second
Ramp Rate and a duration of 3 hours. Click on OK. Click on OK.

For more information on adding Schedules see  the help files and manuals.

3.3.7 Adding C-Bus Controls

Navigate to the "family" page :
If you have the "welcome" page displayed, just right click on the image. 
If you have another page selected, right click on the "family" button. 
You can also select the pages from the page list on the tool bar.
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Select the C-Bus Button toolbar item or Component | Place C-Bus Button menu item. Place the
button near the top of the page. Open the C-Bus Button component by double clicking on it or selecting 
Edit | Component Properties. Select the Group Address called "Kitchen 1". Click on OK. Click on
Yes. 

Repeat this process for the "Kitchen 2", "Dining 1" and "Dining 2" group addresses.

You now have a usable page in your project.

To add a scene button, select the Scenes page. Select the C-Bus Button toolbar item or Component |
Place C-Bus Button menu item. Place the button near the top of the page. Open the C-Bus Button
component. Select a key function of Scene. Select the Movie Scene in Scene Groups. Select the
Status tab and select Scene Indicator. Click on OK. 

3.3.8 Saving

Click on the File | Save menu item. Select a file name and click on OK. 

You now have the basis of a working project. To complete it, you would need to add more C-Bus
buttons, Scenes, Schedules and so forth.
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4 Creating Good Projects

A well designed PICED Project will be easier for the user to use and will be much more visually
appealing. Studies have shown that an aesthetic design of a user interface is perceived to be easier to
use and hence is more likely to be used. The following suggestions will help to produce a well designed
project. 

The Check Project function can be useful for identifying many design errors. It is recommended that you
ALWAYS check the project for errors before completion and follow the suggested changes. This will
avoid some subtle, but potentially serious, problems with your Project.

4.1 Project Structure

The most common graphical interface similar to PICED for the average user would be that presented by
internet browsers. These tend to feature a "Back" button to return to previously visited pages (see the
Menu Based Project Structure). Although this scheme can be used to navigate through any project,
other schemes such as the example project illustrated throughout this Guide may be used. Virtually any
logical system can be used to navigate, and once a user is familiar with a particular scheme the exact
details are unimportant. The key is to make the scheme logical and consistent.

Another idea worth enforcing is that of a limit on the number of levels of menus supported. A project
should have no more than three levels of depth for comprehensibility. If a greater depth is chosen, the
user can become disoriented and frustrated at being unable to find a particular page. If the "three deep"
rule is adhered to this is most unlikely.

The PICED Software offers the options of password protected screens and this is a particularly useful
feature for protecting critical items.

4.2 Pages

The most important thing with regard to page layout is being consistent. The following sorts of things
should be the same on each page, where possible :

Heading position
Fonts
Colours
Position of the navigation buttons (particularly the "back" buttons, if used)

Themes are designed to ensure consistency throughout your project, as well as making it attractive.

First impressions do count. Hence the start-up page is the most critical and should receive the most
design attention. The important factors are :

Aesthetics (use photos or logos)
It needs to be clear what the user needs to do next
Commonly used functions need to be easy to get to quickly
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4.3 Components

A few general rules for the use of components :
Generally speaking, larger Components and icons are easier to see and use. However, the bigger a
component is, the more memory will be used in black and white C-Touch.
Where Components perform similar functions (eg. Page Links or controlling C-Bus), they should look
similar and have similar sizes. Note : Components which are identical to each other use very little
extra memory in black and white C-Touch.
Where there are groups of related Components, they should be close to each other and aligned to
each other.
Avoid placing too many Components on a single page unless necessary, as it can be difficult to find
what is needed.
Design components so that they do not blend into the background too much as a result of similar
colours or textures.
Move features which are rarely used to separate pages, so that they don't clutter the commonly used
pages.
All 3-D buttons supplied with the PICED software have the appearance of being lit from the top left. If
creating buttons with other software (such as Photoshop), ensure that the lighting point is the same. If
a mixture of lighting angles is used, it destroys the illusion of buttons looking 3-D.

Examples of the above rules are shown below.

4.4 Fonts

The number of different fonts should be minimised. The use of different fonts, styles and sizes can create
an effective visual impact, but using too many will be distracting and counter-productive. Each font used
by the Black and White C-Touch also uses up more Resources.

Hints for effective usage of fonts :

Many people find serif fonts (such as Times New Roman) easier to read because the serifs draw the

eye from character to character. 
Sans-serif fonts, such as Arial used in this document, tend to give a cleaner and more modern
appearance.
Using too many fonts makes reading difficult.
Avoid all capital letters as it is harder to read.
Make sure there is enough contrast between the text and the background.
Keep font sizes large enough to be easily read by people with poor eyesight.
Draw the user's attention to important items by the use of a font with different size, colour or style (eg



PICED Tutorial20

© 2015 Schneider Electric (Australia)

bold)
Check spelling and grammar. Few things are more distracting or give a worse impression than poor
spelling or grammar.

4.5 Colours

The use of colours is critical in determining the visual effect of the project. Avoid the excessive use of
different colours as it can make the effect harsh and confusing. 

Colour relationships can be visually represented with a colour wheel which is simply the colour spectrum
wrapped onto a circle as shown below. In the colour schemes below, the term "colour" refers to the hue,
not the saturation or lightness.

Monochromatic Colour Scheme

The monochromatic colour scheme uses variations in lightness and saturation of a single colour. This
scheme looks clean and elegant and produces a soothing effect. The monochromatic scheme is very
easy on the eyes, especially with blue or green hues.
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Analogous Colour Scheme

The analogous colour scheme uses colours that are adjacent to each other on the colour wheel. One
colour is used as a dominant colour while others are used to enhance the scheme. The analogous
scheme has a similar visual effect to the monochromatic scheme, but offers more nuances. The colours
usually match well and create serene and comfortable designs. Make sure you have enough contrast
when choosing an analogous colour scheme.

Complementary Colour Scheme

The complementary colour scheme consists of two colours that are opposite to each other on the colour
wheel. This scheme looks best when you place a "warm" colour (colours near red on the colour wheel)
against a cool colour (colours near green-blue on the colour wheel). The high contrast of complementary
colours creates a vibrant look especially when using fully saturated colours. This colour scheme must be
managed well so that it is not too jarring. Complementary colours are tricky to use in large doses, but
work well when you want something to stand out. Complementary colours should be avoided for text. 
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Split-Complementary

The split-complementary colour scheme is a variation of the complementary colour scheme. In addition
to the base colour, it uses the two colours adjacent to its complementary colour. This colour scheme
has the same strong visual contrast as the complementary colour scheme, but has less "tension". 

Triadic Colour Scheme

The triadic colour scheme uses three colours equally spaced around the colour wheel. The triadic
scheme is not as contrasting as the complementary scheme, making it look more balanced and
harmonious. Triadic colour harmonies tend to be quite vibrant, even if you use pale or unsaturated
versions of the hues. To use a triadic colour scheme successfully, the colours should be carefully
balanced - let one colour dominate and use the two others for accent.

Tetradic (Double Complementary) Colour Scheme

The tetradic (double complementary) scheme is the most colourful because it uses two complementary
colour pairs. This scheme is hard to use well. If all four hues are used in equal amounts, the scheme
may look unbalanced, so you should choose a single colour to be dominant.
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4.6 Usability

The goal of a well designed user interface is to make is usable to someone with little or no training.
Make the functions of the project so transparent in their use that they could not possibly be intended for
any other purpose.

Some tips on making easy-to-use projects :
Follow conventional use of images and words
Where possible, use words to describe the desired action of a component
Use metaphors, but be aware of their limitations. Icons may mean something to some people, but not
to others
Be consistent, so that principles learned in one part of the project apply to other parts too
Put related functions together, and make the components look similar
Avoid having too many choices on commonly used pages, as it takes the users a long time to find
what they want.
If using objects which represent physical objects, they should respond in the same way as the object
they mimic.
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